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Warranty And Software Licence Agreement 

WestDev Ltd and Number One Systems 
This document contains the WESTDEV LTD SOFTWARE LICENSE AGREEMENT which will govern the use of the Westdev and/or 
Number One Systems' products supplied with it. 
You agree to the terms of this agreement by the act of opening the sealed package which contains the storage media on which the software is 
recorded. Do not open the sealed package without first reading, understanding and agreeing the terms and conditions of this agreement. If 
you do not agree to the license conditions you may return the SOFTWARE for a full refund before opening the sealed package.  
1. LICENSE AGREEMENT 
Ownership of the WESTDEV / NUMBER ONE SYSTEMS' Software Package and all its constituent parts supplied by Westdev Ltd 
("LICENSED SOFTWARE") is not transferred to the Customer. Westdev Ltd hereby grants the Customer a non-exclusive license to use the 
LICENSED SOFTWARE on a single computer workstation. Each computer workstation, even on a network, must have its own separately 
LICENSED SOFTWARE. 
2. OWNERSHIP OF SOFTWARE 
As the LICENSEE, you own the magnetic, optical or other physical media on which the LICENSED SOFTWARE is originally or 
subsequently recorded or fixed, but an express condition of this License is that Westdev Ltd and/or the copyright owner retains title and 
ownership of the LICENSED SOFTWARE recorded on the original media and all subsequent copies of the SOFTWARE, regardless of the 
form or media in or on which the original and other copies may exist. This License is not a sale of the original SOFTWARE or any copy. 
3. COPY RESTRICTIONS 
This LICENSED SOFTWARE and all accompanying written materials and all other constituent parts are the subject of copyright. 
Unauthorised copying of the LICENSED SOFTWARE, including software which has been modified, merged, or included with other 
software, or of the written materials is expressly forbidden. You may be held legally responsible for any copyright infringement which is 
caused or encouraged by your failure to abide by the terms of the License. 
4. TRANSFER OF LICENSED SOFTWARE 
The Customer may transfer the LICENSED SOFTWARE provided that (i) this Software License Agreement is transferred with the 
LICENSED SOFTWARE, (ii) the transferee fully accepts the terms and conditions of this Agreement, and (iii) all complete or partial copies 
of the LICENSED SOFTWARE, including copies on data storage devices are also transferred (or destroyed). 
5. MODIFICATION 
You may not otherwise modify, alter, adapt, merge, de-compile or reverse-engineer the LICENSED SOFTWARE, and you may not remove 
or obscure any Westdev Ltd and/or Number One Systems' Copyright or Trademark notices. You must use all reasonable efforts to protect the 
LICENSED SOFTWARE, diskettes, and documentation from unauthorised use, reproduction, distribution or publication, or otherwise in 
violation of applicable law. Please contact our Customer Service department if you become aware of violations of Westdev Ltd's Copyright. 
6. TERMINATION 
The License is effective until terminated. You may terminate it at any time by destroying the LICENSED SOFTWARE and all complete or 
partial copies thereof. It will also terminate if you fail to comply with any term or condition of this Agreement. You agree upon such 
termination to destroy the LICENSED SOFTWARE and all complete or partial copies thereof. 
7. WARRANTIES 
No warranties are expressed or implied with respect to the LICENSED SOFTWARE described, its quality, performance, accuracy or 
suitability for any purpose. In no circumstances will the copyright holder be liable for direct, indirect, incidental or consequential damages 
resulting from the use of this SOFTWARE. 
8. OTHER SOFTWARE 
The supplied disks may contain software whose copyright is owned by third parties. This license agreement shall apply equally to this 
software except where the terms of this agreement are specifically modified by the copyright holder(s). Such modification(s) will be included 
in a machine readable file on the supplied disks. 
9. GOVERNING LAW 
The Governing Law of this Agreement shall be that of England. 
Westdev Ltd will reward anyone giving information leading to successful prosecution regarding breach of copyright. 



 Easy-PC For Windows V9.0 Supplement   5 

Contents 
 

CONTENTS ....................................................................................................................................................... 5 
CHAPTER 1. GETTING STARTED.................................................................................................................... 7 

Installation............................................................................................................................................. 7 
New Option For Checking Web Site For Patches ................................................................................. 7 
Running Easy-PC For Windows 9.0 ..................................................................................................... 8 

CHAPTER 2. NEW FEATURES......................................................................................................................... 9 
User Interface........................................................................................................................................ 9 

New GUI.......................................................................................................................................... 9 
Classic Look..................................................................................................................................... 9 
Document Tabs ................................................................................................................................ 9 
Customisable Menus and Toolbars ................................................................................................ 10 
Sliding Preview bars ...................................................................................................................... 12 
Add Component bar ....................................................................................................................... 12 
Layers Bar ...................................................................................................................................... 13 
Tabbed Windows ........................................................................................................................... 14 
World View.................................................................................................................................... 15 
Databook Changes ......................................................................................................................... 16 

3D View.............................................................................................................................................. 17 
Defining the 3D Packages .............................................................................................................. 18 

Display Dialog .................................................................................................................................... 22 
Layer Viewing (Drawing in Order)..................................................................................................... 23 
Pad Stack Drawing.............................................................................................................................. 24 
Reverse Engineer ................................................................................................................................ 24 
Interactive Schematic Routing ............................................................................................................ 25 
Component Height Checking .............................................................................................................. 26 
Component Push-aside........................................................................................................................ 28 
Preferences Dialog Changes................................................................................................................ 29 
Library Dialog Changes ...................................................................................................................... 30 

Changes to Component Editor ....................................................................................................... 30 
Library Manager ............................................................................................................................ 34 

Signal Components ............................................................................................................................. 34 
Alphanumeric Pin Name Support........................................................................................................ 35 
Add Circle/Add Rectangle Changes.................................................................................................... 36 
Coordinate Edit Boxes on Dialogs ...................................................................................................... 37 
User Defined Coordinate Origin ......................................................................................................... 37 
Asymmetric Grids ............................................................................................................................... 38 
Changes to Units Dialog ..................................................................................................................... 38 
DRC Changes...................................................................................................................................... 39 
Changes to Styles Dialog .................................................................................................................... 40 
Plotting & Printing Changes ............................................................................................................... 40 

Windows Setup Dialog .................................................................................................................. 41 
Plated/Non-plated Drill Hole Support................................................................................................. 41 
NC Drill Output .................................................................................................................................. 42 
Drill Ident Drawing Output ................................................................................................................. 43 
Layer type Oversize ............................................................................................................................ 44 
Testland Support ................................................................................................................................. 44 
Track Fattening ................................................................................................................................... 46 
Automatic Track Necking into SMD Pads .......................................................................................... 47 
New Custom Reports Dialog............................................................................................................... 48 



6   Easy-PC For Windows V9.0 Supplement 

Component Rename ............................................................................................................................51 
CHAPTER 3. EASY-SPICE .............................................................................................................................. 53 

New Spice Update ...............................................................................................................................53 
Speed Increase ................................................................................................................................53 
CircuitSim90 Benchmark Netlists ..................................................................................................53 
Easy-PC Interface Improvements ...................................................................................................53 
Random probing .............................................................................................................................57 
Random Probe Types......................................................................................................................58 
Bias Annotation ..............................................................................................................................58 
Simulation Interface .......................................................................................................................60 
New Models....................................................................................................................................62 

 
 



 Easy-PC For Windows V9.0 Supplement   7 

Chapter 1. Getting Started 
Installation 

Installation is via the autorun setup. If you are not familiar with this process it is 
explained briefly below: 

Insert the CD-ROM into your CD-ROM drive and wait a short time. The CD-ROM will 
run up to speed and an Easy-PC Welcome screen will appear. If autorun has been disabled 
on your computer you must execute the 'setup.exe' program by running the setup program 
through the Start and Run menu option on the Windows task bar. 

The installation is the same for new and existing users alike. Existing users i.e. version 
N0820, V2.1, V3.0 to V8.0 can install V9.0 over an existing installation without deleting 
the old one first. 

With the installer running, once the Welcome screen is displayed, double-click on the 
Install Easy-PC For Windows - Version 9.0 option, or click then press Run. Following 
the instructions on the screen, you should use the same Destination Folder for the 
Program Files as your existing Easy-PC program files e.g. C:\Program Files\Number One 
Systems\Easy-PC 

All other instructions should be followed until completion. 

Click Finish to complete the installation. 

New Option For Checking Web Site For Patches 

On first running version 9.0 you are prompted to choose whether you want Easy-PC to 
check for program updates on the web site. If you say Yes, a new dialog is displayed that 
allows you to set this up. You can also set up this option from the Support option on the 
Help menu and Check for Updates. 

 
When checking for updates, the current version you are running is compared against the 
latest patch version available on the web site, and a message box is displayed if a new 
update is available. You can then opt to get the update, which will launch the appropriate 
Updates page in your web browser to allow you to download and install the update. 
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Running Easy-PC For Windows 9.0 

As with all Easy-PC programs, an icon will appear in the Number One Systems folder, 
you may also wish to create an Easy-PC Shortcut icon that sits on your desktop. 

To start the program, double-click on the Easy-PC icon from the Number One Systems 
folder. 
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Chapter 2. New Features 
User Interface 

New GUI 

Version 9.0 has been updated to provide a Windows Office style look and feel. Menus, 
Toolbars, Shortcuts and Customisation reflect the new look and Menus as well as 
Toolbars may now be customised. 

 
Each of the new GUI features is discussed below. 

Classic Look 

An option to switch back to the Classic look (version 8.0 and previous) is provided in the 
Customise dialog. 

 

Document Tabs 

There is an option, Tabbed Designs, on the View menu to have tabbed design views in 
the main application window. By displaying these, you can easily switch between open 
designs in Easy-PC by simply clicking on the required tab. 
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By hovering the mouse over any of these design tabs, a tooltip showing the full design 
path will be displayed. 

 
There is now a Coloured Look checkbox on the Options page of the Customise dialog 
to switch on the coloured effect for the Easy-PC user interface; primarily the use of 
coloured tabs in tabbed windows. This option is only available if the Classic look is not 
being used. 

 
As well as sliding toolbars, the workbook mode clearly shows the coloured tabs. 

 

Customisable Menus and Toolbars 

Customisation of the menus, toolbars and shortcut keys is done through the Customise 
dialog. This dialog is available from the Settings menu and by right clicking on any of the 
toolbars, menu bar or Easy-PC framework. 
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The Customise dialog has individual tabs for use with the option required as before except 
that Menu and Options tabs have been added. 

 
The Menu tab allows menus for different design types to be customised and provides 
options for changing general menu behaviour and appearance. 

By clicking the Reset button, the currently selected menu/application type will be reset to 
the default setting and your settings will be lost. 

Menu animation and Menu shadows only affect the detailed look of the menus. 

 
The Options dialog is used to customise the look of the toolbars, see previous section 
above under Document Tabs. 

Shortcut Keys 

The Shortcut Keys tab has now been renamed to Keyboard but no other functionality 
has been changed. 
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Sliding Preview bars 

The Preview Bar has been to split in to several individual dockable bars; World View, 
Component Bin, Colours Files Bar, Layers Bar, and a Goto Bar. Each of these may be 
displayed, hidden, docked, floated, auto-hidden (so they can ‘slide’) or combined together 
in a tabbed bar. 

These bars will be automatically hidden when they go out of context and re-displayed 
when they come back into context. 

 
The example above is shown docked on the right side of the interface. 

 
The three small icons (shown circled) on the top of the sliding bar indicate additional 
functionality. Moving left to right; these reveal the shortcut menu, a pin to enable the 
dialog to be sliding to conceal it or docked to be permanently displayed. A cross indicates 
the Close option to dismiss the dialog altogether. 

Dockable toolbars can also be selected using the Dockable Bars sub menu on the View 
menu. 

 

Add Component bar 

A new Add Component dockable bar has been added that is effectively an ‘always-
accessible’ modeless dialog for adding components, and is available for a Schematic or 
PCB design.  

It allows a component to be ‘dragged’ from the selected library directly into the current 
design view. Alternatively, double clicking activates the normal ‘button-up’ add 
component mode and allows multiple instances of the component to be added. The 
component package name is also displayed allowing an alternative package to be chosen. 
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This window is more basic than the Add Component dialog as there is no name filtering 
or Find option. However, because this uses the sliding bar, then it is accessible very 
quickly. 

Layers Bar 

The Layers Bar (previously Layers On/Off in the Preview Bar) has some small changes 
to how it operates compared to version 8. Previously the only action available was to 
select/unselect layers which would show/hide that layer in the design. Now, each layer is 
shown with a checkbox. Clicking the checkbox toggles that layer’s visibility. Single 
selecting the layer name merely highlights that layer in the list whereas double-click will 
make just that layer visible, hiding all others. There are also now context menu entries 
available for ‘All Layers On’ and ‘All Layers Off’. 

 
There are further modifications to match the changes in the Display dialog to show [All], 
[Top] and [Bottom] layers and to allow them to be toggled between visible and invisible. 
Single layer selection on one of these layers will only switch the other 2 off, and will not 
change any of the real layers. Toggling or single selection of a real layer will update these 
layers accordingly. 
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Tabbed Windows 

The window can also contain tabs within any other dockable windows options. You can 
switch between any of these windows by clicking on the appropriate tab. 

 
A tabbed window contains multiple dockable windows and may be manipulated like any 
other dockable window in that it may be resized, docked, floated or auto-hidden. 
Additional dockable windows may be dragged into the tabbed window and existing tabs 
may be dragged out to become individual windows once again.  Tabs may be re-ordered 
simply by dragging them into the desired order.  

Depending on the application ‘look’, Easy-PC will now also provide you with some extra 
features to aid the docking of tabbed windows (these are not available in the Classic 
Look). 

Docking Indicators 

Docking indicators appear to show the potential dock positions which can then chosen by 
releasing the drag with the mouse pointer over the appropriate indicator. The docking 
indicator is different when over an existing docked window. 

 
To reposition a docked window, press and hold down the left-hand mouse button on the 
window title bar border and drag the window frame to the desired docking indicator. Any 
of the four ‘outside’ indicators will allow the window to be docked. By dragging it over 
the centre indicator, it will be added to the existing window as a new tab. 

When used on a dockable window it looks like this: 
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Outside the main docking indicator are four other position indicators. These show that the 
window can be docked to the adjacent edge of the design area of main Easy-PC 
framework. 

World View 

As well as now being a separate dockable bar in its own right, the World View, which 
has previously shown the entire ‘working area’ may now be switched to show just the 
‘design extents’ via a context menu option. 
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Databook Changes 

The Databook now appears as a ‘child’ window inside the main application window. It 
used to be a separate window in version 8. The Databook menu/toolbar that was 
embedded in the separate window is now incorporated into the application menu/toolbar 
in the Customise dialog when it comes into context, (like any other design type).  

The Switch To/From Databook option will now pop the appropriate child window to the 
top. The Add to Design command will operate on the most recent used design view; i.e. 
usually the one from which the switch to the Databook window was made. 
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3D View 

The new 3D viewer allows the ‘flat’ view of the PCB to be annotated so that it can be 
seen as it would be when populated with components after assembly. 

A new menu option 3D View on the View menu in the PCB editor is used to send the 
current design into the viewer. 

The appearance of components in the 3D view is controlled using a new type of library 
(3D packages) which can be edited as new components are added to the library. 

 
Options within the 3D Viewer 

The Options dialog is available on the 3D toolbar and on the Tools menu. The three tabs 
within it allow you to define how the 3D view will look. 

 
The Layers tab will enable you to switch on and off the design layers within the view. 

 
The Colours tab allows you to setup preferred colours for the 3D view. 
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The Settings tab is used to define view parameters such as the thickness of the board in 
the 3D view. 

Each of the entries for Sizes defines a thickness that can be created and viewed. Generally 
speaking, Board and Copper thicknesses would be consistent, whereas you may change 
the Gap thickness to show internal layers more clearly, perhaps to show the internal via 
stacks. 

 

Defining the 3D Packages 

In order to view components in the 3D viewer, you must define the package ‘shape’ in the 
library. There is a new tab in the libraries dialog called 3D View, use this to define 
package libraries. 

 
The package libraries have the file extension .pkg. The contents of the package libraries 
have definitions which relate to a footprint or groups of footprints, for example DIP*. The 
supplied libraries are defined by functional groups i.e. connector, CPS, SMT, DIP 

Package Overview 

3D Packages define how PCB symbols are represented in 3D View images of your PCB 
designs. Each 3D Package has a 'style' (DIL, Quad, Axial, and so on), and various settings 
that control how the 3D image is generated. It also has one or more names that specify 
which PCB symbols the 3D Package applies to, allowing one package to be used to 
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generate the 3D image for many PCB symbols. These names can be specific symbol 
names, or they can include 'wildcards' to match multiple symbol names.  

To generate the 3D view of the actual components on your PCB design, the set of package 
libraries is scanned to find the first package that matches each of the PCB symbols used in 
the design. Because each package can have a basic name and a set of 'aliases' both of 
which can include wildcards, it is possible to create packages that can auto-generate the 
3D view for many PCB symbols. 

3D Edit Dialog 

The 3D View tab gives a summary of the selected item, and small pictures in 3D and 
'normal' view of a corresponding footprint. The PCB symbol that is used for this dialog 
will be the first one found that matches the rules defined by the selected package. 

 
Edit 3D Package 

This dialog is used to edit or create a 3D Package definition. Fields on the dialog allow 
you to specify which PCB symbols this package would be used for, and the style and 
other properties of the package.  

Using the dialog 

The dialog is accessed from the 3D View tab of the Libraries dialog. Choose the package 
you wish to edit, and click the Edit button. The dialog is divided into several sections, 
each of which is described below. Depending on the type of package, and other factors 
like the number of pins, some sections or controls may not be available or appropriate, or 
may not have any effect on the resulting picture. The best way to see the effects is to try 
them out and see how the Preview picture changes. 
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Package Style: The main control in this section, which specifies the general type of the 
package. Available styles are: 

Axial Generally two-pin through-hole components like 
resistors and diodes 

 

Box Rectangular components where the box is taken from 
the overall size of the component 

 

Can Vertical cylindrical components such as large 
capacitors 

 

Chip Surface-mount chip-type components such as chip 
resistors and capacitors 

 

DIL Dual-in-line components such as DILs, SOICs 

 

Quad Components (generally surface mount) with pins on 
all four sides 

 

Shape General components where the 3D body shape is 
derived from the 'best fit' shape in the PCB symbol 

 
Height: the overall height of the component body.  

Inside: for some types, this specifies the amount by which the body should be undersized. 

Standoff: the distance between the board surface and the underside of the component 
body. 
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Body Colour: the colour of the component body. 

Top Closed/Coloured/Colour: Some packages styles allow the top of the body to be 
open or closed, and/or set to a different colour to the rest of the body. 

Pins 

This section specifies how the pins should look. 

 
Style: Type of pin. Some of the pin styles are sized and positioned to fit particular styles 
of package. For example, J-Lead, Gull-wing and DIL pins will only work for package 
styles such as DIL and Quad where the pins are around the edge of the component. 

Colour: Pin colour 

Length: Overall length of pin. This does not have any effect for some types such as J-
Lead and DIL which measure the pin length automatically from the midline of the 
component body. 

Offset: Allows the pin to be offset up or down the component. 

Mounting Holes/Pins 

Certain styles allow some of the pins to be designated as mounting holes/pins. If Count is 
set non-zero, the last pins on the PCB symbol are drawn using the specified mounting 
style instead of the pin style. 

 
Applies To Symbols 

This section specifies the PCB symbol names to which this package will apply. The first 
name is the name by which the package will be listed in the Libraries dialog. The other 
list shows additional names to which this package will match. Any of these names may 
contain wildcards, as shown in the example below.  
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Preview 

This section shows a preview of the 3D package you are editing, as long as an appropriate 
PCB symbol can be located in the available libraries. Just below the preview is shown the 
name of the PCB symbol that is being used.  

You can see the effect of changing any of the controls on the dialog straight away. The 
picture can be rotated in any direction (in the same way as for the main 3D view itself) by 
moving the cursor into the preview window, pressing and holding down the left mouse 
button and then moving the mouse. Buttons are also provided to allow you to zoom In and 
Out of the preview picture. 

Display Dialog 

Pad Colours 

Pad colours in the PCB Display dialog can now set on individual layers to allow 
exceptions and oversizing to be distinctive from other items on that layer. 

 
Layer Sets 

You can now make layers [All], [Top] and [Bottom] selectable or pickable in their own 
right.  

These ‘special’ layers should not be confused with a ‘special effect’ layer. Setting a 
special layer off/on is a way of hiding/showing through-hole or surface-mount pads on 
one side of the board without affecting other pads, and without changing the visibility 
settings of the individual ‘real’ layers. They should be seen as an override to the 
individual layer settings. For example, not-displaying [Top] will hide all surface mounted 
pads on the top side of the board and re-displaying [Top] will make visible only the real 
layers on the top side that were visible before [Top] was not-displayed. Although 
switching the visibility of a ‘special’ layer doesn’t affect the real layers that comprise that 
set, changing the visibility of one of the constituent layers will reset the appropriate 
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‘special’ layer if necessary. So, for example, if [Bottom] was set not-displayed, 
subsequently switching Bottom Copper from invisible to visible would force [Bottom] to 
be reset to visible also. Doing the opposite and switching Bottom Copper to invisible will 
only set [Bottom] invisible if no other real layers remain visible on the bottom side of the 
board.  

Layer Viewing (Drawing in Order) 

Layer Order Drawing 

Now in PCB, when a design is repainted all layer-based design items will be redrawn in 
correct layer order such that all items on upper layers will appear on top of items on lower 
layers; for example, tracks and copper on the top layer will appear on top of tracks and 
copper on an inner layer, which in turn will appear on top of tracks and copper on the 
bottom layer. 

In Easy-PC V9.0 this option will be enabled by default, but if you do not wish to use this 
feature, it may be switched of by un-checking the Layer Order Drawing option in the 
Display tab of the Preferences dialog. 

 
For the best effect when using the Layer Order Drawing it is best to switch off the Merge 
Track/Shape Colours options in the Display dialog. 

Reverse Layer Order 

There is a new command, Reverse Layer Order, available on the View menu for a PCB 
design. This allows the normal Layer Drawing Order to be reversed so that lower layers 
draw on top of upper layers. It may also be added to a toolbar or assigned to a shortcut 
key by using Customise. 
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Pad Stack Drawing 

In a PCB or PCB Symbol design, a pad will be now be displayed on screen with any 
defined oversizing or exceptions visible. The oversizes and exceptions will be displayed if 
the particular layers on which they are defined are enabled and will appear in the 
appropriate layer order as viewed from above, this is reversed if reversed layer order is 
active. 

 

Reverse Engineer 

The Reverse Engineer tool is designed for use where there is no corresponding 
Schematic design for the existing PCB design. It is not intended for use where a PCB 
design is modified and the changes are to be reflected in the Schematic (the Schematic is 
always considered the ‘master’ design in this situation). 

 
Where a PCB design has been created, and if the PCB design is used to create ‘local’ 
libraries with the Schematic symbols added to the components in the new library, you 
must update the components into the PCB design first before using the Reverse Engineer 
option. Use the Update Component option from the Tools menu. 

If you opt to use PCB only components, the Schematic Symbols/Components will be 
auto-generated from you when the Reverse Engineer option is selected. This method will 
work fine but will create dummy Symbols only, symbols that are shown as boxes with a 
representative number of terminals. 

Using the Reverse Engineer dialog will enable you to select the new Schematic name, 
which library folder to use and the Schematic Technology File name. You can also elect 
to Route the Design automatically once autoplaced. Once back in the Schematic design, 
all Symbols are automatically placed. 

Autorouting selected Symbols 

If you choose not to autoroute the design, you can selectively route them afterwards by 
using shortcut menu options on selected pins or components. 

It does 95% of the work in creating a Schematic. A bit of tidying-up up is required of 
course but it is a big time saver for those that choose to work this way. 
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Interactive Schematic Routing 

The Sketch connection path mode has been introduced into the Schematic design editor. 
This allows you to interactively make a connection between two points using a basic 
‘sketching’ mode, or by using a point-to-point mode. 

Using the Sketch Connection mode from the Tools menu, you can add connections to the 
design. Once in this mode, this is verified by the display of a modal cursor, a cursor which 
shows a mode. 

 
This picture shows the 
approximate path that you 
‘sketch’ in. The modal cursor is 
also shown. 

 This picture shows the 
final result after 
completion and tidy-up. 

 

Immediately after using sketch mode, the tidy routine will snap the connection onto the 
grid and remove all the rough edges for you. Once added, the connection path can be 
tidied up using normal connection editing options. 

Shortcut menu options 

While using the sketch mode, you can use options form the shortcut menu. 

 
Point to Point mode 

On the shortcut menu, you can select Point To Point mode. This allows you to point and 
click to add a connection path. After the mouse click, the path will be tidied back to the 
last click, this gives you a ;guided’ routing path which is automatically tidied as it goes 
along. This may be a preferred mode of operation to the normal sketch mode. 
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Component Height Checking 

Height Checking has been added to the Easy-PC PCB design editor. This allows you to 
define a special height area on the design with a maximum allowed height. The maximum 
height allowed can be assigned on the whole board (using the Spacings dialog) or on an 
area basis (using Height Checking Areas). 

Using Height Checking 

The process for using this option is this: 

1. Define the Height Value to be used in the Spacings dialog. 

2. Optionally, define the Side to be checked and the Max Allowed Height for that 
layer in the Spacings dialog. 

3. Add a Value of Height to the components to be checked in the design. Do this in the 
component library or in the design itself (using Properties or Component Values 
editor) on a component basis (it is more efficient to do this once in the component 
library for each component type). 

4. Run the Design Rules Checking option and select Height under Manufacturing 
rules. 

Spacings dialog 

On the Spacings dialog in the PCB design editor, there are new controls for setting up the 
maximum component heights for Top and/or Bottom layers, and choosing the default 
Value name for components to define their height. 

 
New Add menu option 

On PCB Add menu, there is a new option to add Height Check Areas. These areas are 
layered and have a maximum component height setting available in their Properties. 



 Easy-PC For Windows V9.0 Supplement   27 

 
When the area is selected, its Properties will allow you to change the area Height for 
checking. That is, components within this area will have their Value checked against the 
maximum defined for the Area. 

 
Component Properties 

For Properties of components, you should add a Height value (Height is the default value 
but you can define and use any Value you wish). This value can be assign locally within 
the design on a component basis but it is more efficient to define this in the component 
library. 

 
Design Rules Checking 

On DRC dialog, a new checkbox for Component Height under Manufacturing has been 
added. Use this for checking the Values and Spacing Heights of components. 
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Component Push-aside 

Components can now be ‘pushed’ while interactively moving them. This feature is 
enabled though the Preferences dialog and PCB Interaction, or while actually moving 
the component using options on the shortcut menu. Options are available for pushing to 
select the push mode as Never, Continuous and On-drop. The push direction can also be 
set to Both, Vertical and Horizontal. You can also set whether components use 
Springback (with springback set the component being pushed will continually attempt to 
return to it's original position before the pushing started. This is particularly useful on a 
tightly packed board where space is at a premium). 

 
There are corresponding settings on Preferences dialog and PCB Interaction. 
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Preferences Dialog Changes 

The Preference dialog has been split into more tabs to make it easier to read and use. 
Changes and additions to the Preferences dialog are discussed elsewhere. 
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Library Dialog Changes 

Changes to Component Editor 

The Component Editor dialog has undergone a significant change, not enough to be 
completely different so that you have to relearn it but enough to improve the functionality. 

 
Gates Listing 

You will initially notice that the grid has been rotated so that each gate now appears down 
the list rather than being across the page, gates are numbered a, b, c etc. All cells not 
greyed out are editable fields. 
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Shortcut Menu Usage 

Within both the Schematic and PCB Symbol Preview windows, you can use functionality 
available on the shortcut menu. 

 
New Edit Package Dialog 

This dialog is used to add or edit packages to the component. Alternative PCB Symbols 
can be added here as well. The order in which they appear is how they will be added in 
the Schematic editor when transferring from Schematic to PCB designs. Other packages 
under the top most item will be available as alternatives using the Properties dialog. 

 
New Net (Class) Names Column 

A new Net (Class) Names column has been added to the right side of the grid. This is 
used to predefine net names or net class names where a known signal name is required. 
This may be useful for pre-assigning power and ground signal names to gates or for use 
with specific power and ground symbols, such as +5V and GND for example. 

New Shortcut Menu in Component Grid 

A new shortcut menu in the Component Grid allows you access to additional 
functionality. 
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You can also use this dialog to Assign Pins 1:1 (PCB symbol pad numbers – Component 
Pin numbers). The Name Pins by Row/Col option is used to automatically number pins 
which require alphanumeric names/numbers (see be in the section on Alphanumeric Pin 
Name Support). 

The Change Symbol Gate option enables you to add more Schematic Gates to the 
Component. This is also available from the Component Editor toolbar. 

 
Properties 

The Properties option opens the Properties dialog for this component. 

 



 Easy-PC For Windows V9.0 Supplement   33 

Edit Package Option 

The Edit Packages option allows you to define package alternatives for this component 
and to set the package default, that is, the one that is used in initially when you use Add 
Component in your design. 

 
Edit Gate Option 

The Edit Gates option enables you to add or remove gates from this component and to 
change the order in which they appear in the component grid. 

 
Change Gate Symbol 

The Change Gate Symbol option is used when you need to add or replace a gate symbol 
for another one. 
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Apply To Other Gates 

This option is used to apply the name in the selected cell to all other cells where the gates 
are the same. 

 

Library Manager 

The Library Manager now remembers last selected item and ‘topmost’ item in the 
contents list, this means it will return to the same items next time you open the dialog. 

Signal Components 

Components which represent pre-defined signal connections such as power and ground, 
can be defined more easily in the component library. 

 

 
Within the Component Editor, the component grid now has an additional field for 
defining the Net (Class) Name for each pin on a component. This can be a Net name, or 
enclose the name in parentheses to make it a net class name (hence the column title). This 
is used to auto-connect this pin to the given net / net class when the component is added to 
a design. This makes the addition of these components much quicker when used. 



 Easy-PC For Windows V9.0 Supplement   35 

Alphanumeric Pin Name Support 

Alphanumeric pin names are often used to identify pad numbers in the PCB design rather 
than pad numbers. Typically, pads on devices such as BGAs (ball grid arrays), or some 
connector types they would use pad names, such as A1, A2, A3, B1, B2, B3 etc. On 
BGAs these also represent columns and rows of the pads to make pad location easier. 

 
Within the modified Component Editor dialog, you can now specify the Component 
Pin Name/Number. On normal components, this would be same number/name as the 
PCB Symbol number. 

 
By selecting in the Component Pin grid, new shortcut menu options enable you to define 
the column. 

The Name Pins by Row/Column option is used to assign pin numbers to grid based 
components such as BGAs when using the Component Editor. 
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Pin Order 

These controls allow you to choose the direction in which the pins will be numbered. The 
settings you need to choose here will depend on the order in which you have numbered 
the pins in your PCB symbol. With the settings shown above, the pins would be named 
starting at the top left, then stepping rightwards across each column to the end of the first 
row, then moving down the rows. 

Spacing 

These controls allow you to specify the step between the pads that constitute each row and 
column of your PCB symbol. The initial settings will be automatically determined by 
examining the arrangement of pads on your symbol, but depending on the order in which 
the pads were created you may need to adjust these values. 

Naming 

This control allows you to specify particular characters that will be skipped over when 
creating the pin numbers. 

The results 

Once you have set up the dialog controls and clicked OK, the pin numbers will be 
automatically created and added to the corresponding cells on the pin assignment grid of 
the component editor. 

The first pin will be numbered A1, the second A2, and so on until the end of the row or 
column is reached. The next row or column will start with B1, and so on until all the pins 
are numbered.  

Add Circle/Add Rectangle Changes 

Behaviour of the Add Circle and Add Rectangle options is now consistent. Starting a 
shape with no keyboard keys pressed down still does corner-to-corner shape. 

Starting a shape with the Ctrl key down produces a centre-to-outside shape. 

Starting with the Shift key pressed down, the Rectangle shape is constrained to be 
square. 

Unfortunately this reverses the default behaviour of the Add Circle option, but was 
thought it better to be consistent.  

Ctrl and Shift together can be used to constrain the Rectangle shape to a Square and 
starting from the centre. 
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Coordinate Edit Boxes on Dialogs 

All coordinate edit boxes will now accept unit name after the number. Thus you can enter 
16.5mm even if the current units are thou. Typed value is converted into equivalent 
current units and then applied. 

 

User Defined Coordinate Origin 

You can now move the system coordinate origin to anywhere in the design. So if you 
need to, you can define it to the lower left hand side of the board outline or board centre 
for example. 

The origin can be moved using the Relative Coords dialog on the Settings menu or 
interactively using commands on the shortcut menu. 

 
Shortcut menus for selected design items allow you to set the and go to the System 
Origin and go to the Relative Origin. 

 
Set Origin with an item selected now sets the origin at the position of the item. 
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Asymmetric Grids 

Grids can be set so that the X and Y grid positions can be different. From within the 
Grids dialog on the Settings menu, there is a Different Y check box to change the Y grid 
settings. 

 

 
On the Screen Grid page of the Grids dialog, you can now make the screen different or 
the same as the Working Grid. Like the Working Grid, you can also make the Screen Grid 
use a Different Y grid. 

 

Changes to Units Dialog 

The Units dialog now has two unit settings, so you can choose the pair of units (and their 
precision) instead of setting just thou and mm. There are also additional unit types 
available for cm, Mils and Inch. 
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Care must also be taken when switching units to ensure that the Precision of the units is 
changed accordingly. For example, Imperial units in thou would normally be defined to 0 
(Zero) decimal places, while Metric units in millimetres would be defined to 2 or 3 
decimal places because of the rounding and accuracy required. This is especially 
important for the definition of drill sizes. 

One final important point for unit precision, be careful if changing between the unit types 
on the same design. It is possible to sometimes define an item as say 12.99 and to round 
the unit precision up to 0 decimal places which then shows 13 as the displayed size. But 
because the value has not been changed, the value is still 12.99 as the stored value and the 
value which is then used throughout the design for all operations. 

DRC Changes 

There are additional checks under Manufacturing on the Design Rules Checking dialog 
to check. 

 
New Checks 

 Minimum annular ring (drill getting too close to outer edge of pad) 

 Minimum paste size (pad undersize causing paste pad to be too small) 

 Minimum track width (track segment too narrow) 

 Min neck length (necked/fattened track segment too short) 

There are additional boxes on the Spacings dialog to set these values. 
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Changes to Styles Dialog 

The Style dialog has changed, entries in the various styles grids are now sorted by name.  

The dialog will also pre-select the style corresponding to the first appropriate selected 
item in the current selection (first line-style for selected components, etc). 

 

Plotting & Printing Changes 

The plot Position tab (Plotting & Printing option) has changed, the ‘extents’ buttons are 
now radio buttons to show which part of the design you have selected for plotting, and 
there is a new button for ‘board outline’ which sets the plot extents to the extents of the 
first board outline in the design. 
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Windows Setup Dialog 

An extra checkbox has been added to the Windows Setup dialog in Printing & Plotting, 
this allows you print multi-layer plots in layer order. 

 

Plated/Non-plated Drill Hole Support 

The Pad Styles dialog on the Settings menu can define both Plated and Non-Plated 
through hole types. There is a check box to define that a hole is Plated. 

 
This plating status is used when outputting an NC Drill output file and a Drill Ident 
Drawing. 



42   Easy-PC For Windows V9.0 Supplement  

NC Drill Output 

To further support the use of plated and non-plated through holes, the NC Drill output 
from within the Plotting & Printing option now supports both plated hole types. 

 
A new checkbox has been added to the NC Drill setup dialog for Separate Files for 
Plated and Unplated Holes. With this checked, a separate drill file for un-plated drill 
holes is generated with (Unplated) appended to the file name. The report also lists the 
two sets of drills separately.  

An example report is shown below: 

NC Drill Output 
--------------- 
    Plated drill holes 
    ------------------ 
    "C:\Designs\Fsk - Drill Data.drl" 
    Tool             Size        Count 
    ------------------------------------ 
    T000        00.032 in            6 
    T001        00.035 in           10 
    ------------------------------------ 
    All                             16 
    ------------------------------------ 
NC Drill Output 
--------------- 
    Unplated drill holes 
    -------------------- 
    "C:\Designs\Fsk - Drill Data (Unplated).drl" 
    Tool             Size        Count 
    ------------------------------------ 
    T000        00.032 in           22 
    ------------------------------------ 
    All                             22 
    ------------------------------------ 
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Drill Ident Drawing Output 

Drill ident drawings or drill drawings as they are also known, are an optional output file 
that can be produced. These are supplied to your board manufacturer and are used to 
indicate the position and type of drill holes within the design. Typically, where you have 
used mixed drill sizes, you would need to indicate these to the manufacturer so that the 
correct sizes are used. 

 
A new Drill ID Setup dialog enables you to setup the drill hole and letter/shape 
association. When the drill ident drawing is produced, holes and sizes are indicated by 
shapes and letters, this makes the hole types easier to identify. The setup table enables this 
association to be defined. 

 
Other options within this dialog allow you to define how and where the idents will be 
positioned once the plot is produced. It is normal to produce this plot as either a Windows 
printed plot, or as a pen plot (if you use a pen plotter). It can also be supplied as a Gerber 
file along with the other manufacturing plots and sent as part of the plot ‘set’. 
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Layer type Oversize 

From within the Layer Type dialog, you can now define the over and undersize required 
for when producing solder resist or solder paste mask plots. These are additional plots 
used during the manufacture process. There are additional controls on the Edit Layer 
Type dialog allow you to specify the under/oversize values to be used. 

 
With the Oversize check box selected, you can make pads and vias bigger or smaller by 
the defined amount. The amount defined can be an absolute amount (using the current 
design units) or a percentage of the pad width.  

Typically, for a Solder Resist plot, the pads in the plot would be specified slightly bigger 
(to allow for any mask movement or shrinkage), and a Solder Paste Mask would be 
specified to be slightly smaller to allow for the melting of the solder paste when the 
surface mount device ‘leg’ is soldered to the board. Before adjusting these values, check 
with your board manufacturer to see what he recommends. 

Testland Support 

Testlands are used to define ‘probe’ points along a net within the PCB design. These 
probe points are used in automatic test equipment as ‘landing’ sites for test probes. These 
probe points can be any pad or via in the design. 

Any pad or via can be selected and made into a Testland from within the Properties 
dialog. 
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Other than pads and vias within the design, if you require ‘floating’ pads to be added to 
the design, then add these using the Add Pad option. You must also connect these to the 
required net by using the Add Connection option. 

From within the Display dialog, the colour of the Testlands can be changed to highlight 
them in the design. 

 
When you choose the Testland List menu option from the Output menu, it will open a 
dialog where you can choose between IPC format and 'readable' format. 

 
The IPC Standard Format report will output an industry standard Testland netlist that 
manufacturers will use for automatic test equipment. 

An example of the Readable Text Report is shown below: 

Testland Report 
--------------- 
 
Report Written : Thursday, July 07, 2005 
Design Path    : C:\Number One Systems\Designs\Laser.pcb 
Design Title   :  
Created        : 07/07/2005 09:22:30 
Last Saved     : 07/07/2005 09:22:41 
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Editing Time   : 28 min 
Units          : thou (precision 4) 
 
Type         Name            X               Y      Side   Net 
--------------------------------------------------------------
Comp Pad     PL2.24       2850.0000       4050.0000    All  0V 
Comp Pad     PL2.25       2750.0000       4150.0000    All  0V 
Comp Pad     PL2.26       2750.0000       4050.0000    All  0V 
Via          -            2850.0000       3925.0000    Both 0V 
-------------------------------------------------------------- 
Counts 
--------------------- 
Comp Pads           3 
Free Pads           0 
Vias                1 
--------------------- 
Total               4 
--------------------- 

Track Fattening 

There are new options to allow tracks to be ‘fattened’ up allowing more track copper to be 
laid down on the PCB. 

  
The Net Class track settings on the Settings menu are used to define the Nominal and 
Minimum widths.  

Where the Nominal width used causes a DRC violation and with the Neck Track feature 
enabled, the option will ‘neck’ down to the Minimum Track Width defined. 
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New options Fatten All Tracks and Fatten Selected on the Tools menu and shortcut 
menu while editing tracks enable this. 

 
The minimum length setting can be defined in the Spacing dialog under the Min 
Neck/Fatten Length rule. 

 

Automatic Track Necking into SMD Pads 

While editing a track, it is possible to enable automatic track necking if the ‘fat’ track is 
too wide to enter a pad without causing a design rule violation.  

 
Like the Fatten Track option, the Net Class track settings are used to define the Nominal 
and Minimum widths. Where the Nominal width used causes a DRC violation and with 
the Neck Track feature enabled, the option will ‘neck’ down to the Minimum Track 
Width defined. 
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To operate in this mode you need two features enabled. You need Online DRC enabled 
and Neck Tracks enabled. Both of these features are enabled in the Preferences dialog 
under PCB Interaction. 

 
The ‘stub’ distance can also be defined. This is the distance between the pad and the start 
of the ‘fat’ track segment. 

 
This setting is defined in the Spacing dialog under the Min Neck/Fatten Length rule. 

 

New Custom Reports Dialog 

A new menu option (on the Output menu) in Schematic and PCB editors opens the 
Custom Reports dialog. From here you can run the supplied inbuilt reports, plus you can 
create user-formatted parts lists using a series of dialogs that allow you to choose which 
columns to include in the report and how the components should be grouped and sorted. 
This includes the ability to calculate totals of selected columns (e.g. Qty, or perhaps Cost 
attribute). 

New default files are supplied as examples and are installed into a \Report Templates 
folder under the main Easy-PC installation folder. 



 Easy-PC For Windows V9.0 Supplement   49 

The Options button allows you to customise how the reports will operate and where they 
are located. 

 
The main dialog displays a list of the Built-in reports and a list of User Reports. 

 
By selecting on of the User reports in the list and pressing Edit, or by clicking on the 
New button you enter the initial report editing dialog. A custom report can contain a 
number of elements, each of which adds to the report. The elements currently in the report 
are listed in this dialog, and you can use the buttons down the side of the list to change the 
contents of the report. 

 
This dialog enables the format of the report to be defined. Each line in the list represents 
an action that will be taken when the report is run. The action is converted into a 
formatted line in the report. 
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A list of buttons enables you to edit the contents of a user-defined parts list. 

This dialog allows you to edit the contents of a component list contained in a user-defined 
parts list. The settings on this dialog control how the output will be formatted, which 
components should be included, and in which order they are listed. 

 
Each of the options listed in this dialog are fully described in the online help which is 
installed with the Easy-PC product. 
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Component Rename 

From within the Component Rename option, if the Include Components On: Both Sides 
selected, it renames top side first then bottom side, instead of mixing the sequence of 
names on both sides. 

The Start Numbering From: entry allows you to define the start number for 
Components rather than it always starting from 1. 
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Chapter 3. Easy-Spice 
New Spice Update 

The features detailed below are available in Easy-Spice version 2.0. Version 2.0 is like 
any other update and is a chargeable option. 

Speed Increase 

The Spice ‘engine’ itself has been updated to be significantly faster (between 50-150% 
simulation speed improvement depending on the circuit) and more accurate with 
convergence improvements. 

CircuitSim90 Benchmark Netlists 

Of the industry standard CircuitSim90 benchmark netlists (57 in all), Easy-Spice now 
runs all 57 to the point at which they converge and produce an accurate result. 

Easy-PC Interface Improvements 

New Simulation menu 

Easy-Spice version 2.0 now has its own menu – Simulation. On this menu is the Run 
Simulation command and Simulation Parameters, along with other options. 

 
Once the design has been set up, the Run Simulation options is used to run the simulator. 

During creation of the design before simulation, you can use the Simulation Parameters 
dialog to define which mode the simulator will run in. 
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The Simulation Parameters dialog is now a tabbed dialog rather than being separate 
menu items. This dialog allows parameters to be defined without running simulator. 

This dialog also allows multiple analysis modes to be used at the same time, i.e. AC, DC, 
Transient. 

Extra Transient Analysis Parameters 

The Transient Analysis dialog has been separated out and expanded. New options for 
Data Output Options and Advanced Options can be used. 
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DC Analysis 

DC Analysis can now do a temperature sweep. 

 
Select the radio button for the type of item you want to perform the sweep on. Choose 
between sweeping a device value or the global circuit temperature (using Temperature 
Sweep). The value edit boxes will change to accommodate the chosen sweep type. 

New Noise Analysis mode 

Like AC analysis, AC Noise analysis is a small signal mode. The circuit is treated as 
linear about it's DC operating point and the contribution of all noisy devices to a 
designated output is computed. The total noise at that output is also calculated and 
optionally the noise referred back to an input source may also be computed. 

 
Extra Spice Data 

An additional menu option, Extra Spice Data now appears as a tab in the dialog. 
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This is used to include simulator controls, local SPICE models and other user supplied 
SPICE statements at the end of the SPICE netlist. 
 
The data entered is held in a file with the same name as the schematic design or project 
but with a ".spi" file extension. 

Type the simulator commands you wish to include at the end of the netlist. There are 
several buttons below the data box to aid you in this process. Use the Delete All to clear 
the data box. Note that All text pasted into the data will replace any currently selected text 
in the edit box. 

Import Models 

Use this button to paste a copy of all models and sub-circuits used in the design into the 
extra SPICE data. 
 
The advantage of including all used models with the schematic design is so they can have 
their parameters altered locally without changing the model library , and to make the 
schematic design files complete. If the design files are passed to another designer, or 
brought out of archive, it should still simulate. 
 
Clicking on the Import Models button will bring up the following dialog to allow you to 
choose to paste the used models directly into the data, or to paste a reference to a file 
containing the models.  

 
When OK is pressed the models are extracted from the Simulator model libraries and 
saved in a file with same name as the schematics design appended with a .mod extension.  
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Random probing 

Random probing is a mode that allows you to ‘probe’ around the design without rerunning 
the simulator each time. Use this interactive tool to plot the voltage and current on 
selected nets and device pins in the design. 
 
This is a simple alternative to adding fixed voltage or current probes to the schematic 
design before simulation. The Easy-Spice Simulator will then generate graphs of the 
probed voltages and currents automatically when simulation is run. 

 
With Random Probe selected from the Simulation menu, a modal cursor with the probe 
image is displayed. You must have already run a simulation for the design for this mode 
to operate. On selection of a net, an extra response line is drawn in the graph window 
overlaying the existing graph. 
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Random Probe Types 

Different probe types are available on the shortcut menu when in the Random Probe 
mode. 

 
The first eight options are the standard probe types that match the fixed probes available 
in the SPICE component library.  
 
Pick nets when using the Voltage probes and component pins when using the Current 
probes. The Differential Voltage probes asks for you to select two nets before plotting 
the voltage difference. The first is the "signal node" and the second the "reference node. 
 
The new curve will be added to any existing graph if the X-axis has the same units. 
Otherwise, a new graph sheet will be created.  
 
If plotting the dB or voltage phase and the AC Analysis used a logarithmic sweep, the x-
axis will be logarithmic. You can change this to linear using the Edit Axis function on the 
simulator's graph window Axes menu. 

An additional option allows you to Delete all fixed probes from the design. 
 
Note: You can plot the current into a subcircuit pin as well as those of primitive 
components. This means you can plot the terminal currents (and power) of power 
MOSFET and IGBT devices directly. Most other SPICE products require you to place a 
voltage source in series with the device pin to plot current in a MOSFET. 

Bias Annotation 

Bias Voltage and Current Markers are components used to annotate the schematic with 
the results of a DC Operating Point analysis, displaying the voltage on the net, or current 
on the pin, they are placed on. The values shown on the markers are updated each time 
you simulate. 

The voltage and current markers can be added interactively and automatically to the 
design. 
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With the markers added, if the simulator is run, the results can be annotated into the 
design using Update Values option on the Simulation menu. 

 
There are menu options to Show/Hide Values in design, Update Values and Delete 
Values. You can change the formats of the values using the Options page in the 
Simulation Parameters dialog. 

Bias Marker Components 

Bias Marker components should have a single pin. The voltage marker component should 
have the component value SpiceBiasMarker = Voltage, and the current marker 
component should have the value SpiceBiasMarker = Current. Both should also have 
the component value SpiceValue = 0, ready for receiving and displaying the analysis 
result.  

The name of the component to be used for Voltage Markers should be set up in the 
Simulation Options dialog. This is to enable the automatic addition of voltage markers to 
know which component to use.  

There are special components Bias Voltage Marker and Bias Current Marker provided 
in library SPICE.cml.  
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Adding Bias Markers 

Individual bias markers can be added from the SPICE library using Add Component. 
Bias Voltage Markers should have their pin attached to the net you wish to display the 
value for, and Bias Current Markers should have a connection from their pin to the device 
pin you wish to display the value for.  

Use the Add Bias Markers option from the Simulation menu to automatically add a 
voltage marker component to each net in the schematic design.  

First all existing Markers on the Schematic Page will be removed. Then a Bias Marker 
will be added to all nets on the page.  

If you have already run a Simulation, you may now update the values displayed on the 
markers by using the Update Bias Marker Values option. 

Simulation Interface 

Drag n Drop models 

You can now drag models or library folders onto the Command Shell window to add 
new libraries to Easy-Spice. 

 
Dropping the folder from the Windows Explorer dialog onto the Command Shell 
window displays the Select Library dialog. 
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Much better Graph dialog editing 

Below is a summary of the new features found within the new simulator interface: 

 Can now resize all dialogs used 

 Windows XP look when running on XP 

 Toolbar on command shell 

 Toolbars and graph legend panel are dockable 

Graph Annotation: 

 Curve marker, free text, boxed text and captions 

 Add legend into graph for printing 

Better Cursors: 

 New cross hair cursor 

 Position displayed on graph 

 Improved cursor positioning 

New features in the graph windows  

 Now have fixed menus at top of program. 

 Auto-vertical scrolling 

 Highlight curves 

Axes: 

 Switch between log and linear after graph has been created 

 Can adjust the height of digital axes 

 Y Zoom improvement 

 Re-order grids in Y direction (separate digital and analogue) 

Saving: 

 Graph to binary and recover later 
 Graph to metafile 

 

Define Fourier plot 

A Fourier spectrum of a signal can be obtained in a number of ways. You have a choice of 
using the default settings for the calculation of the Fourier spectrum or you can customise 
the settings for each plot. The following menus use the default settings: 

Graph menu and Measure Plot Fourier of Curve 

Graph menu and Measure Plot Fourier of Curve (Cursor span) 

The Define Fourier option on the Graphs and Data menu displays the following dialog: 
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You will see a dialog similar to that shown for Plotting arbitrary expressions will be 
displayed but will include a Fourier tab. Click on the this tab to display the Fourier 
analysis options. 

.PARAM Command 

The PARAM command can now be used in library models and sub-circuits. It defines a 
simulation variable for use in an expression. Expressions may be used to define device 
parameters, to define model parameters, for arbitrary sources and to define variables 
themselves. 

Support of .FUNC Function 

Easy-Spice now supports the .FUNC function. .FUNC defines a function that can be used 
in a model or device parameter expression, a parameter defined using .PARAM or in an 
arbitrary source expression. 

New Models 

New models have been added to the Easy-Spice product libraries. 

 313 new models have been added to the IR, LTC and Zetex libraries. 

New libraries have been added for the following: 

 Infineon library containing 450+ models 

 Magnetic Core libraries containing 50+ models 

New Components/Symbols have been added to support the new models supplied. 

 


